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1.0 Introduction

Almanac is a calendar/information utility for the Microsoft 
Windows operating environment.  It provides traditional 
calendar displays in month and year format as well as a popup 
desk set for day-to-day notes and schedules.  Global 
configuration parameters can be configured to select the face 
and size of the display fonts used to compose the calendar, and
the position and size of the main and popup windows.  
Configuration files (auto-load modules) and overlays allow you 
to customize calendars for all of your business and personal 
needs.

An overlay is a set of data which provides Almanac with the 
information it needs to calculate the days that events will occur 
on.  The types of events Almanac will calculate include weekly, 
monthly, and annual events by day or date, as well as 
birthdays, wedding anniversaries, and others.  Up to ten 
overlays may be specified in a configuration file.  This release 
contains two sample overlays which define holidays for the 
United States and Canada.  (We are very interested in acquiring 
information for the holidays of other countries and would 
appreciate all efforts to forward such info to us.  Thank you!).

In addition to specifying overlay files, Almanac auto-load 
modules allow you to configure options for calculating religious 
holidays (Christian and/or Jewish), phases of the moon, and 
calendar mode (Gregorian/Jewish).  A location data base is used
to select a geograhic location for each auto-load module.  This 
information is used to calculate the time and azimuth of sunrise
and sunset for each day.  All of the menu selections under 
'Config' are stored in the auto-load module except the master 
directory path.

Almanac can be easily navigated using the keyboard and/or 
mouse.  The mouse interface makes extensive use of intuitive 
'point and shoot' actions.  Double-clicking on any day will 
activate either a sizeable popup window to display all events for
the day or the desktop mode with day calendar, alarm clock, 
notepad and scheduler.  Double clicking on the last or next 
month calendars in the upper corners will change the current 
month.  The same action over the year (centered between 
last/next month) will activate the YearView popup.  The 
keyboard can be used to access all features.

Almanac can print the month or year calendars, notes, or 
schedules with notes for any range of time.  As with the video 
display, Almanac allows you to compose your output using all of
the fonts available to your printer.

1.1 Installation

Almanac MUST be installed using the included ALMSETUP utility.
ALMSETUP is a Windows application which will install and 
configure Almanac within your Windows environment.  If you 
are a registered user, ALMSETUP will convert any support files 



you may have created with versions .91 or later (except the 
location data base) so they can be used with version .95.  
ALMSETUP can be run from floppy or hard disk as long as all of 
the Almanac release files are included in the current directory.  
If you install from a hard disk, ALMSETUP will relocate release 
files if necessary (duplicate the file and then delete the 
original).  Files will be copied and left intact if installed from 
floppy drives A: or B:.  Please refer to the accompanying 
ALMSETUP.DOC file for more information.



2.0 Operational Basics

Almanac is a calendar/scheduler which can be customized using
calendar overlays and a variety of configuration options.  Any 
combination of options and overlays may be saved in an auto-
load module from the File menu.  'Open...' an auto-load 
module from the 'File' menu and automatically setup a 
different Almanac environment.  The File menu has a 'Save' 
and a 'Save As...' selection to allow auto-load modules to be 
updated or created.  A default file, ALMANAC.ALM, is built 
during installation and is used to initialize Almanac if it is 
started without specifying an ALM parameter on the command 
line.

Overlays allow fixed and floating events such as holidays, 
birthdays, anniversaries, etc... to be calculated for your 
calendar display.  Up to ten overlays may be automatically 
recalled using an auto-load module.  Organizing overlays into 
logical categories will help you define more flexible auto-load 
modules.  The Overlay menu has selections to clear the current 
overlays, add an overlay to the current overlays, create a new 
overlay, edit an existing overlay, and display the currently 
active overlays.

Configuration options can be selected from the Config menu to:

o Calculate phases of the moon

o Choose a geographic location (used for 
sunrise/set/azimuth)

o Configure the desktop scheduler 

o Calculate Christian holidays (Xmas, Easter, etc...)

o Calculate Jewish holidays

o Select Gregorian or Jewish calendar modes

o Select brief (small popup) or deskview (full screen 
desktop)

mode to be activated when a day is double-clicked.

o Configure the directory paths where Almanac will 
access

overlay and desk files from.

o Specify the master Almanac directory (global 
support files)

Preferences are used to customize the video display and initial
window areas.  This menu has options to:

o Automatically activate the popup (brief or desktop)
when



Almanac is started.

o Add or remove a sizing frame for the brief popup.

o Change the display fonts.

o Save the current location and size for the main and
brief

windows to be used when Almanac is started.



2.1 Quick Start 

When started, the initial Almanac window will display the 
current month calendar with prior and succeeding month 
displays in the upper corners.  The current day will be 
highlighted.  Double-click the mouse on one of the days to 
popup more information.  If you like, double click once again on 
the popup text area to switch the popup to maximized desktop 
mode.  The popup mode can be switched between brief or 
desktop modes by double-clicking on the window background.

Double-click on the prior or succeeding month displays and you 
will activate them as the current month.  Double-click on the 
year in the main header and the YearView calendar is displayed.
Use the mouse or cursor keys to change the month selection.  
Use PgUp and PgDn to quickly move to a different year.  Hit 
'Esc' to remove YearView or hit 'Enter' or the space bar to 
change the main display to the YearView month and year.  
Double-click on the date/time status bar and return to the 
current date.

The keyboard can also be easily used to navigate Almanac.  Use
the arrow keys, home, end, page down and page up to change 
day selections or move from month to month.  Use the space 
bar to activate popup information for the current highlighted 
day.  The TAB key can be used to toggle keyboard input back to 
the main calendar.  The YearView and Today features are 
available from the main menu or as Control key combinations.

3.0 Menu Selections

3.1 File

3.1.1 Open...

Opens a dialog box to allow selection of a new auto-load 
module for the Almanac environment.

3.1.2 Save

Saves current option and overlay settings to the current auto-
load module.

3.1.3 Save As...

Opens a dialog box to allow the current options and overlay 
settings to be saved to a new or existing auto-load module.

3.1.4 Print...

Activates the Print dialog to allow selection of month, year, 
notes, or schedule printing, and the range of time to be 
processed.  A checkbox is supplied to control the printing of 
notes for schedule items.  The dialog box can be expanded by 
selecting the 'More' option for more specific selection of fonts 



and sizes for different portions of the calendar.  Fonts selections
are presented based on the current printer selected (see 
Change Printer).  The different text areas are:

Title: Main calendar header.
Main Dates: Date 

numerals on main and year calendars.
Main Text: Text placed in

main calendar date boxes.
Last/Next Month: Small calendar dates.

Dates: Date headers 
for notes and schedules.

Notes: Note text.

When printing month calendars, notes, and schedules, the print 
area may be sized using the height, width, and margin settings. 
These values are initially chosen to allow for a one-quarter inch 
margin on the top, left, and right edges of the printable surface 
area.

NOTE:  Almanac will print in portrait or landscape mode as your
printer provides.  Selecting landscape mode (see Change 
Printer, below) will provide a larger area for month calendars to 
be printed on.



3.1.5 Save Print Settings

This selection is made available after printing is performed.  It 
will save any changes you have made to print fonts and 
margins for during the current session.  This information will 
then be selected as default settings for later print requests.

3.1.6 Change Printer...

Allows the selection of configured printers and printer options.  
Depending on your printer(s), this option may provide access to
paper orientation, font cartridges or downloadable fonts, and 
other features which can be used to extend your print options.

3.1.7 Exit

Ends the current Almanac session.

3.1.8 About Almanac...

Displays version and copyright information about Almanac.

3.2 Overlay

3.2.1 Clear

Removes all current overlays.

3.2.2 Add...

Opens a dialogue box to allow the addition of overlays to the 
current display.  Overlay files are used to define holidays, 
birthdays, anniversaries, or any other calendar event for 
computational purposes.  See section 4.0 for a description of 
the overlay file format.

3.2.3 Current...

Displays the names of all currently active overlays.



3.2.4 New...

Used to create a new overlay file of events.  Events can be 
created, modified, or deleted.  Selecting 'New...' will create a 
new event, prompting you first for the type of event, and then 
displaying a dialog to allow entry of information to define the 
event.  Current event types are:

Date:  A fixed, one-time event.  Requires input of month,
date

and year.

Weekly:  A recurring event every week.  Requires 
start/end dates

and day of week.

Bi-weekly:  Similar to weekly except every other week.

Monthly Date:  A recurring event every month on the 
same date.

Requires start/end dates.
Example: Every 15th of the month.

Monthly/Day of week:  A recurring event every month 
on the same

day of the week (e.g. 1st Tuesday, 3rd Monday, Last 
Friday.

Requires start/end dates and week/day of week.

Annual Date:  An annual event occurring on the same 
month and

date each year.  Requires month and date.
Example: New Year's Day

Annual/Day of week:  An annual event occurring on 
the same

week/day every year.  Requires month and week/day of
week.
Example: Labor Day (1st Monday in September)

Annual/Float:  An annual event occurring on the same
weekday of every year, but not necessarily the same 

week.
Requires month, date (first date that the event COULD 

fall on),
and day of week.
Example: Sadie Hawkin's Day (1st Saturday after 

November 11)

Birthday:  Requires the person's name, and month, 
date, and year

of birth.  Will display event such as 'Bob's 32nd Birthday'
when

name is set to 'Bob'.

Wedding Anniversary:  Requires the couple's names, 
and month,

date, and year of their wedding.  Will display event such 



as
'Rick & Carol's 7th Anniversary' when name is set to 

'Rick &
Carol'.

Span:  Used to define a one-time span of consecutive 
days such as

a vacation, business trip, or similar event.  Requires 
start/end

dates.

All event types listed above which state that start/end dates are
required must have a month, date, and year entered that 
indicate the beginning and ending period that Almanac should 
calculate for.  Start and end dates are always initialized to the 
current date.  Use the 'Start/End' pushbutton to toggle 
between entry of start and end dates.  It is not necessary that 
the start or end date actually fall on the first or last ocasion of 
the calculated event.

Selecting 'Copy...' will create a new overlay entry and initialize 
its definition using the currently highlighted overlay event.  This
is useful for entering several events with common definitions.

Select 'Edit...' to edit the highlighted event, or 'Remove' to 
delete the highlighted event from the overlay.

The sort order of the event listbox can be changed to 
descending date, ascending date, alphabetical events, or sort 
by event type.  Dates which have start/end time frames will be 
sorted to the top or bottom of the list on a date sort.  The type 
identifiers which appear in the first two columns in the sort by 
type are provided only to distinguish one event type from 
another.

All events are created or edited using the same dialog box.  
Different controls are activated or de-activated depending on 
the requirements of the event being defined.  The red-letter 
checkbox, for example, is provided to indicate traditional non-
work holidays and is currently de-activated when defining and 
event such as a birthday or wedding anniversary.  The start/end 
pushbutton is activated when an event requires separate 
starting and ending dates.



The 'Shade>>' pushbutton expands the dialog box, allowing 
access to colors and shade or hatch patterns to be used to color
the day(s) of the event.  You will have a selection of two, eight, 
or sixteen pure colors to choose from depending on your 
monitor type and the level of Windows you are running under.  
Selecting the 'Style'  pushbutton will advance the shade/hatch 
style and display the result in the sample window.  Almanac 
uses the selected color and style to paint the background of the
main month's date window.  Some colors or styles may not 
produce desirable results depending on your monitor or 
customized Windows color scheme.  Almanac provides all 
possible selections so that you may choose the best style for 
your requirements.  Multiple events falling on the same day will 
have any selected backgrounds overlayed.  You should take 
care to avoid similar background styles from overlaying each 
other.

3.2.5 Edit...

Used to edit events in an existing overlay file.  See section 
3.024 above for a description of editting items.

3.3 Select

3.3.1 Today

Returns the calendar to the current date.  Mouse users can 
double-click anywhere on the date/time status bar below the 
menu bar for the same action.

3.3.2 Date...

Opens a dialog box to allow the calendar to be moved to any 
valid date by entering the month, date, and year.

3.3.3 DayView

Activates additional popup information for the highlighted day.  
Use the mouse double-click or just hit the spacebar for quicker 
selection.

3.3.4 YearView

Activates the display of the YearView window showing twelve 
months of calendar information.  The mouse and keyboard 
arrows, Home, and End can be used to highlight a month.  The 
keyboard can decrement or advance the year quickly with Page 
Down and Page Up (not available through mouse).

3.4 Config

3.4.1 Moon Phases

Toggles the display of the four phases of the moon on and off.  
When selected, the moon phases are calculated on a yearly 



basis.  This will cause a slight delay for calculations upon 
initialization and when moving across year boundaries.  The full 
and new moons are calculated within a two minute tolerance.  
The first and third quarters are approximated for performance 
considerations to within the hour and therefore may disagree 
occasionally with more accurate sources.

3.4.2 Location

Selecting location will activate a dialogue box allowing a choice 
from the locations found in the ALMLOCN.DAT file.  This 
information is used to calculate the sunrise/set times and 
directions.  ALMLOCN.DAT comes provided with definitions for 
many major cities.  This file can be edited with Windows 
NOTEPAD or any other ASCII text editor to create a custom 
menu of locations.  The format for each entry is:

 City, ST:  LatDeg Min Sec LongDeg LngMin LngSec GMTOffset 
StdZone[/DayZone DayLight Start Month, Start Date, End 
Month, EndDate];

The information in [brackets] pertains to daylight savings time 
and is optional for each entry.  You can find the latitude and 
longitude for locations in most atlases, encyclopedias, almanacs
<grin>, and other reference publications.

3.4.3 Scheduler...

Allows various time parameters to be changed for the 
scheduler.

3.4.4 Christian Holidays

When selected Almanac will compute Ash Wednesday, Palm 
Sunday, Good Friday, Easter, and Christmas holidays.

3.4.5 Jewish Holidays

When selected Almanac will compute Rosh Hashanah, Fast of 
Gedalya, Yom Kippur, Sukkot, Shmini Atzeret, Simhat Torah, 
Hannukka, Tu B'Shvat, Fast of Esther, Purim, Passover, Shavuot, 
and four additional fasts.

3.4.6 Gregorian Calendar

Selects the standard Gregorian calendar as the display mode.  
Toggling between Gregorian and Jewish modes maintains the 
highlight on the same day, making date conversions an easy 
chore.

3.4.7 Jewish Calendar

Selects the Jewish calendar as the display mode.  Due to design 
complications several Almanac features are unavailable in 
Jewish mode.  These include the YearView window, the printing 
of year calendars (months are O.K.), and the access to DeskTop 
mode (data is architected for Gregorian months).



3.4.8 Brief DayView

When Brief Dayview is selected, any popup requests (see 2.0, 
Almanac Basics) will activate a smaller window in the center of 
the screen which allows you to view information computed from
any overlay file (*.AOL) which will not fit in the main display.  
Days in the main display which are flagged with the plus 
rectangle in their lower right corner have more information than
can be displayed in their box.

3.4.9 Desktop DayView

When selected, popup requests will activate the full-screen 
desktop display with day calendar, overlay viewer, notepad, and
alarm clock.  See Desktop Mode below for more information.

3.4.10 Data Paths...

Opens a dialog box to allow the overlay and desk data search 
paths to be changed.  Changing the overlay path to a new sub-
directory will cause all current overlays (from the old overlay 
path) to be removed from the display.  The new path can now 
be used to add overlays.

Changing the desk data path will cause the desktop section of 
Almanac to clear any current notepad or scheduler information 
and re-initialize from any desk data files found in the new sub-
directory.

3.4.11 Master Path...

Opens a dialog box to allow the master path to be changed.  
The master path is the sub-directory Almanac will use for 
required system files (fonts, location data) and all auto-load 
modules.  This parameter is not usually changed after 
installation.



3.5 Prefences

3.5.1 Autostart DayView

When selected, Almanac will automatically popup the brief 
DayView window or enter desktop DayView (see at startup.

3.5.2 Size DayView Frame

Adds or removes a sizing frame to the brief DayView popup.  
Select this option and size the popup window to your 
preference.  You can de-select this option, if desired, and then 
select 'Save Desktop' (see below) to save the current size and 
location of the popup window.

3.5.3 Fonts...

This selection will activate a dialog to allow custom selection of 
fonts for your video display.  Most of the fonts Almanac uses to 
create the display can be adjusted from this dialog.

3.5.4 Save Desktop

This selection will save the current size and location of the main
and popup windows to the global prefrences file, ALMANAC.MST.
Almanac will initialize its main window at startup and the popup
window when requested using this information.  You may still 
change the position or size of either window during a session 
without affecting this default information.

4.0 Desktop Mode

The current desktop provides a foundation for normal personal 
scheduling.  Every day can be associated with a page of the 
notepad for general daily notes.  Each appointment entered into
the scheduler is also associated with its own page of the 
notepad to allow free-form text to be attached to appointment 
entries.

There are five desktop 'objects'.  The mouse or the TAB key can 
be used to switch between them.  Exit the desktop mode with 
the ESC key, ALT-F4, or the system menu close selection.  
Switch from desktop to brief view mode with the minimize arrow
or system box selection.

The Calendar is the familiar day of the month type and accepts
input from the arrow, home, end, etc.. keys to move from day to
day and month to month.  The mouse can be used on the arrow 
icons to change the day or month, as well.

The DayView, or overlay viewer, displays the information 
calculated from overlays as well as the sunrise/set information.  
If required, a scroll bar will be provided to allow viewing of all 
information.  If the scroll bar is present, the DayView window 
can be TABbed to for keyboard access.



The Alarm Clock is available to set up to five general purpose 
alarms.  Access the alarm dialogue by double-clicking on the 
Alarm Clock or by hitting the space bar when the clock is 
selected.  Alarms are only valid for the current day (setting to a 
time earlier than present will have no effect).  Set an alarm by 
selecting any of the five alarms in the selections listbox.  Now 
select the alarm time, message, and sound for the alarm.  
Select the 'Set' button to record your alarm setting.  You MUST 
use the 'Set' button to confirm any alarms that you enter or 
change.  Alarms are stored in the desk data file for the current 
month and will remain valid from session to session.



The Notepad is available for up to 800 characters of input 
made up of characters, spaces, and carriage returns (also 
backspace for erasure).  TAB characters are not allowed.  The 
notepad has been programmed with proportional text for an 
aesthetic appearance.  Every attempt has been made to 
provide accurate word wrap and text formating within reason (if
you lean on a key and wrap a full line of characters with no 
space break you will frustrate my word/line break scan and send
the notepad into never-never land, [I will resolve this 
promptly]).  The mouse, arrow keys, home, end, and page keys 
can be used as with most other simple editors.  The notepad 
also supports text operations with the clipboard.  Cut, Copy, 
Clear, and Paste functions are provided.

The Scheduler allows appointments to be entered.  The 
viewing area can be scrolled throughout the entire day.  The 
initial position of the schedule scroll and the resolution of the 
time can be modified from the Option menu under the 
Scheduler... selection.  A fixed summary bar located to the left 
of the display area is provided to quickly see 
scheduled/unscheduled time over a larger time period.  The 
summary bar timeframe can also be changed from the 
Scheduler... dialog.

Access the scheduler dialogue by double-clicking on the 
Scheduler text (gray) area, or by hitting the space bar when the
Scheduler is selected.  Using the mouse will initialize the start 
time of your desired entry using the position the mouse was 
clicked on.

NOTE:  The mouse is currently the only way to access an 
existing schedule event for modification.  Double-click 
anywhere on the appointment's rectangle to recall the 
information for editting.

Enter text for the appointment (up to 40 characters) in the edit 
box.  Short-cut time formats can be used to enter start, end, 
and alarm times.  Twelve hour clock users can enter "3P, 3PM, 3
P", etc...  Always use two digits to specify minutes, if required 
(e.g., 3:15P).

The checkbox labelled Alarm can be used to activate an alarm 
for the appointment.  If you have activated the alarm, an alarm 
time can be entered and an alarm 'sound' may be selected from
the Alarm Sound group box.

Appointments will be displayed as rectangular areas on the 
Scheduler's viewer display and summary bar.  You may select 
the notepad page for any appointment by clicking once in any 
area of its rectangle.  Any changes to the notepad must be 
saved before moving to another page.

Note indicators will be displayed on the monthly calendar to 
show the presence of text on the notepad and/or appointments 
in the scheduler.

Almanac will create files with a name format like FEB90.ALD to 
store information maintained in the Desktop mode.  These files 



may be deleted from disk as the information they contain 
becomes out-of-date.

4.1 Desktop Menu

4.1.1 Notepad

The Notepad menu selections are 'Save' to save the current 
notepad text and 'Restore' to revert the text in the notepad to 
the last save.

4.1.2 Edit

The Edit menu contains the standard Cut, Copy, Paste, and 
Clear clipboard functions which can be used with the notepad.

5.0 Tips on using Almanac

Almanac provides several levels of configuration information. 
Screen and printer fonts are stored in the global configuration 
file, ALMANAC.MST.  Window size and position, saved with the 
'Save Desktop' option, is also stored here.  This information 
applies to the entire Almanac system.

All selections available on the 'Config' menu, except for the 
'Master Path', are stored in the auto-load modules, along with 
overlays selected from the 'Overlay' menu.  This information 
applies to Almanac environments saved and opened from the 
'File' menu.  Note that the directories used to store/retrieve 
overlay and desk files can be varied for different auto-load 
modules.

5.1 Organizing Support Files

5.1.1 Overlay Files

Multiple overlay entries per auto-load module allow you to 
create overlays by theme or logical groups and then use 
appropriate combinations of overlays for different requirements.
You may choose to select US-HLDAY in most or all of your auto-
load modules.  Create separate overlays for family 
birthdays/anniversaries, friends, and business relationships.  
Review your overlay organization if you find yourself entering 
the same event into more than one overlay.

If your business spans several states or countries, you may find 
it convenient to create auto-load modules for each geographic 
location and select one or more overlays within each ALM which
specifically apply to its region.

The organization and scope of your Almanac environments is 
limited only by a maximum of ten overlays per auto-load 
module (you can manually add more), and all overlays must 
exist in the same directory for a particular ALM.



5.1.2 Desk Files

As with overlays, the desk file directory can be selected within 
the auto-load module.  The overlay and desk directories are 
chosen independently of each other.  You may decide that one 
overlay directory and one desk top are enough.  If you would 
like to keep a business desk top as well as a personal one, you 
can create two directories for desk files and select one or the 
other in your ALMs.  Note that many different overlays can be 
stored in an overlay directory, but only one 'set' of desk files 
can be stored in the desk file directory.  Desk files are named by
gregorian month and year such as JUN90.ALD and JUL90.ALD.

5.2 Windows 3.0

Much attention has been given to making version 0.95 totally 
compliant with Windows 3.0.  Actually, Almanac never has 
intentionally attempted to 'circumvent' Windows programming 
rules.  Running under the strictly monitored environment of 
Windows 3.0 386 enhanced mode did turn up a few minor 'bugs'
which had previously went unnoticed.

A full-color icon for use with Program Manager, ALMANAC.ICN, 
has been included for Win 3.0 users.  This file will be copied to 
your Windows directory by ALMSETUP, and can be used when 
defining any Almanac program items in a program group to 
obtain a more appropriate icon for Win 3.0.  Use the 'Change 
Icon...' selection and enter ALMANAC.ICN into the file name edit 
box.

If you encounter any 'Unrecoverable error - terminating 
application!' messages, please forward the particulars of where 
and how the error occurred to me via any of the methods below.



Please feel free to call or drop me a line with any comments, 
criticisms, or suggestions you may have!

Dial (714)986-5653 and enter "A - L - M" from your touchtone 
phone or:

I can be reached on CompuServe - User # 71630, 1703 or:

Please send me a note to:

       Impact Software
       2321 S. Magnolia Ave. #9D
       Ontario, CA   91761

Best regards,

Len Gray


